TABLE OF CONTENTS

Introduction ............................................................................................................................ 1
Managing Your Exchange Mailbox ......................................................................................... 1
    Best Practice Using Microsoft Outlook Exchange ............................................................. 1
    Determining Mailbox / Folder Size ...................................................................................... 2
Getting Started .................................................................................................................... 3
    Launching Your Outlook Application: ................................................................................ 3
    Outlook 2007 Window ........................................................................................................ 4
    Navigation Pane ................................................................................................................. 5
Outlook 2007 Mail Folder ....................................................................................................... 6
    Previewing Mail Messages .................................................................................................. 6
    Opening Mail Messages ..................................................................................................... 6
    Creating Signatures .......................................................................................................... 7
    Using the Global Address List (GAL) .................................................................................. 9
Creating a Mail Message ....................................................................................................... 10
Adding Mail Attachments ................................................................................................... 11
Recalling Sent Messages ..................................................................................................... 12
Auto Reply Using the Out of Office Assistant ..................................................................... 13
Personal Outlook Address Book ........................................................................................ 15
Personal Folders in Outlook (.pst) ......................................................................................... 16
Creating a Personal Folder (.pst file) .................................................................................. 17
Accessing Junk Email Options ............................................................................................ 20
Archiving Mail ..................................................................................................................... 21
Outlook 2007 Calendar Folder .............................................................................................. 23
Outlook 2007 Calendar Window ........................................................................................ 23
Choosing a Calendar View .................................................................................................. 24
Viewing a Specific Date ....................................................................................................... 24
Sizing the Calendar .............................................................................................................. 25
Creating New Appointments ............................................................................................... 25
Using the OWA Mail Folder ........................................................................................................56
Using OWA Calendar Folder ....................................................................................................61
Using OWA Contacts Folder ...................................................................................................62
Using OWA Tasks Folder .........................................................................................................62
Outlook 2007 Folder Permission Levels ..................................................................................63
INTRODUCTION

This document discusses basic concepts and focuses on using the Mail, Calendar, Contacts, Notes and Task Folders of Outlook 2007 Exchange to organize your workday. This includes creating items within the different folders of Outlook, sharing folders and assigning permissions for shared folders.

MANAGING YOUR EXCHANGE MAILBOX

Managing your mailbox is very important to help maximize campus resources and to ensure that the mailbox containing the Mail, Calendars, Contacts, Tasks and Notes Folders, do not exceed the 500mb quota. The Mail folder should be monitored daily as email, voice mail messages and attachments often use large amounts of space.

**Best Practice Using Microsoft Outlook Exchange**

- Following best practices will help you:
  - Organize your mailbox by using a system that is meaningful to you
  - Move items from your Inbox to your organized folders DAILY
  - Empty Deleted Items and Junk E-Mail folders DAILY
- The items in the Mail, Calendar, Contacts, Tasks and Notes folders contribute to the 500mb quota provided with the Exchange Mailbox.
- Local folders are located on your hard drive and are not available via Outlook Web Access (OWA) (see Figure 1, below).

Figure 1 – Outlook Folder List
Determining Mailbox / Folder Size

1. Click **Folder List** shortcut.
2. Click **Folder Size**…
3. The **Folder Size** display window shows **Total Size (including subfolders)** and **Subfolder** breakdown (see Figure 2, below).

Figure 2 - Folder Size Display Window
GETTING STARTED

Launching Your Outlook Application:

1. Click the Start button on the Taskbar at the bottom left corner of your Windows screen.
2. Click the Microsoft Office Outlook 2007 icon.
3. Click on the Mailbox – NAME to display the Mailbox – NAME – Outlook Today window (see Figure 1, below).

Figure 1 - Microsoft Outlook – Outlook Today View
Outlook 2007 Window

The Outlook window for the Mail, Calendar, Contacts, Tasks and Notes Folders are similar in that they contain the **Standard Toolbar**, a **Navigation Pane**, and a **Viewing Window**. Each window will provide different viewing options specific to the folder. Below is the **Mail Folder - Inbox** display window (see Figure 2, below).

**Figure 2 – Inbox – Microsoft Outlook**

1. **Menu Bar** – Tools for use with Outlook 2007
2. **Navigation Pane** – Shortcuts to Folder List and Outlook folders.
3. **Viewing Pane** – Displays the contents of the selected folder.
4. **Reading Pane** – Displays the contents of the selected item without opening a separate window.
5. **Standard Toolbar** – Contains shortcuts for Outlook 2007 actions
**Navigation Pane**

The **Navigation Pane**, located on the left side of the Outlook window, provides shortcut access to the folders in your mailbox. Selecting a folder will display its contents in the window above. Currently the **Mail** folder is selected (see Figure 3, below).

Figure 3 – Navigation Pane

1. **Mail Folder**: where mail is composed, sent, received, and read.
2. **Calendar Folder**: where appointments and meetings are created and viewed.
3. **Contacts Folder**: contains contact information not available in the Global Address List.
4. **Tasks Folder**: where tasks are create, sorted, tracked, and assigned.
5. **Notes Folder**: where electronic post-able notes are created and viewed
6. **Folder List**: Displays the folder structure in a hierarchical format; contains **Folder Size** link
7. **Shortcuts**: Area to create and view additional shortcuts.
OUTLOOK 2007 MAIL FOLDER

The Outlook 2007 Mail Folder contains the mail subfolders used to assist the user in organizing the contents of the Inbox. In addition to the Inbox and the default provision of subfolders, users can create additional subfolders to meet their needs. The Deleted Items and the Junk E-mail folders should be emptied on a daily basis.

Previewing Mail Messages

1. To preview a message, click on the Inbox folder.
2. Turn the Reading Pane on; Select View—Reading Pane—Right / Bottom (see Figure 1, below).
3. Highlight the message to preview.
4. Content is displayed in the Reading Pane.

Opening Mail Messages

1. To open a message in a separate window, double click the message.
2. To close the message, click the Close icon in the upper-right corner of the message window.
Creating Signatures

You can create custom signatures for different types of audiences.

1. On the **Tools** menu, click **Options**, and then click the **Mail Format** tab.
2. Click the **Signatures...** button (see Figure 2, below).

![Figure 2 – Options - Signature](image)

3. The **Signatures and Stationary** window displays (see Figure 3, below).
4. Click the **New** button.

![Figure 3 – Signatures and Stationary](image)
5. In the **New Signature** window, enter a name for your new signature in the **Type a name for this signature** field and click **OK** (see Figure 4, below).

![Figure 4 - New Signature](image)

6. The new signature name will appear highlighted in the **Select signature to edit** list (see Figure 5, below).

![Figure 5 - Select and Edit Signature](image)

7. Enter and format your signature information in the **Edit signature** window (see Figure 6, below).

![Figure 6 - Edit Signature Section](image)
8. In the **Choose default signature** section, select the appropriate signatures for **New messages**: and **Replies/forwards**: (see Figure 7, below).

9. Click **OK**.

**Figure 7 – Choose Default Signature**

![Choose default signature](image)

**Using the Global Address List (GAL)**

**What is the Global Address List (GAL)?**

- The **GAL** is a list of CSUN Exchange users that is ‘Globally’ accessible by all Exchange users.
- The **GAL** is listed in the **Address Book** field (see Figure 8, below).

**Figure 8 - Address Book – Global Address List**

![Address Book – Global Address List](image)

- The IT department can setup distribution groups (groups of email addresses) by department or project, to improve productivity and communication.
• Restrictions can be placed on distribution groups so only certain users are allowed to send to it. An example would be a policy by which only executives could send to the distribution group containing ‘all employees’.
• If you want to see the members of a distribution group, simply right-click on one of the group lists and select ‘Properties’ and the properties window will appear.

Creating a Mail Message

1. Click the New Mail Message icon; top left hand corner.
2. The Untitled – Message (HTML) display window opens (see Figure 9, below).

Figure 9 - New – Untitled – Message (HTML) Window

3. Click the To, Cc, or the Bcc button to add names from GAL or other contact list. Separate names with a semicolon (;) (see Figure 10, below).

Figure 10 - New – Select Names Global Address List
4. Click **OK**
5. In the message body, type the message.
6. Click the **Send** button (see Figure 11).

Figure 11 - New – Completed Message

---

**Adding Mail Attachments**

1. On the **Message** tab - **Include** group, click **Attach File**, to add documents, spreadsheets, etc or **Attach Item** to add an Outlook item; email, calendar items etc.
2. Locate and highlight the file to attach (see Figure 12, below).
3. Click the **Insert** button.
4. Complete message and click the **Send** button.

Figure 12 - New Message with Attachment
Recalling Sent Messages

There may be times where you send a mail message and quickly realize you didn't mean to send the message, or you noticed an error in the e-mail that needs to be fixed. Exchange 2007 has an option to recall messages. However, there are several caveats:

- The recipient must be an Outlook Exchange user.
- Message must be unread.
- Copy of message may be saved on e-mail server.

To Recall a Message:

1. Select the Sent Items folder (see Figure 13, below).

2. Double-click the e-mail you wish to recall to open it.

3. Select Actions - Other Actions… - Recall this message… (see Figure 14, below).
4. Choose to either Delete unread copies of this message or Delete unread copies and replace with a new message.
5. Check or uncheck the Tell me if recall succeeds or fails for each recipient box as desired (see Figure 15, below).

Figure 15 – Recall This Message Options

6. Click OK.
7. If you chose to replace the e-mail, enter in your new message and click Send.

Auto Reply Using the Out of Office Assistant

1. From the Tools menu, click Out of Office Assistant (see Figure 16, below).

Figure 16 – Tools - Out of Office Assistant
2. In the Out of Office Assistant display window, Do not send Out of Office auto-replies is the default setting (see Figure 17, below).

Figure 17 - Out of Office Assistant – Default Setting

3. Click Send Out of Office auto-replies and the Only send during this time range box.

4. The Start time: and End time: fields are activated and allow you to set the dates when you want auto replies sent (see Figure 18, below).

Figure 18 - Out of Office Assistant Activated

5. Auto-reply once for each sender with the following messages: allows you to create a response for incoming messages received from: (see Figure 19, below).
   - Inside My Organization

Figure 19 - Inside My Organization - Message
• **Outside My Organization (On)**

On the Outside My Organization (On) tab, select the Auto-reply to people outside my organization check box, AND select My Contacts only (recommended) (see Figure 20, below).

**Figure 20 - Outside My Organization (On) Message**

The Global Address List, GAL, is routinely updated based on university information. Users can create a personal Outlook address book to save information not available in the GAL.

**Personal Outlook Address Book**

To create a personal address book:

1. In the Navigation Pane, right-click Mailbox – your name and, select ‘New Folder’. (see Figure 21, below).

**Figure 21 – Create a Personal Address Book**
2. The **Create New Folder** display window opens (see Figure 22, below).
3. In the **Name** field, enter a name for the folder.
4. From the **Folder contains** drop down list, select **Contact Items**.
5. In the **Select where to place the folder** box, select where you want the folder to be located. Selecting **Mailbox – YOUR NAME** makes the folder available when using OWA.

Figure 22 - Create New Folder

6. Click **OK**
7. The new personal address book will be available in the **Address Book** section (see Figure 23, below).

Figure 23 - Address Book – My Contacts

### Personal Folders in Outlook (.pst)

- Personal folders provide many benefits such as:
  - Allowing you to create back-up copies of your folders on your hard drive.
  - Enabling you to move items to your hard drive to avoid exceeding your disk quota on the CSUN Exchange server.
- Choose which type of Personal Folder is right for you
  - Create a Personal Folder to transfer individual e-mail messages onto your local...
hard drive.
  - Create a Personal Folder to make a copy of your entire email account including messages, contacts, and calendar events.
  - Saving individual items into a Personal Folder
    - Personal folders are stored locally; on your hard drive
    - Available only when using a specific computer
    - Not available when using OWA
    - Is no longer part of the Exchange environment; backups are recommended.

**Creating a Personal Folder (.pst file)**

1. Click on the File Menu.
2. Select Data File Management. (See Figure 24 below)

Figure 24 – File - Select Data File Management

6. The Account Settings display window appears (see Figure 25, below)
7. Under the Data Files tab, click the Add button.

Figure 25 – Account Settings Display Window
8. The New Outlook Data File display window appears (see Figure 26, below).
9. Select Office Outlook Personal Folders File (.pst) from the Types of storage: list
10. Click OK.

Figure 26 – Type of .pst file

11. The Create or Open Outlook Data File window appears (see Figure 27, below).

Figure 27 - File Name .pst file

12. Select the location for the folder in the Save in: field.
13. Type a descriptive name for your Personal Folders in the Name: field. This name will appear in the Navigation Pane.
14. Check the Save as type field reads Personal Folders Files.
15. Click OK.
16. The new **Personal Folder** appears in the **Account Settings** window (see Figure 28, below).

Figure 28 – New .pst Folder

17. Click **Close**.

18. The **Personal Folders** appears in your list of Outlook folders in the **Navigation Pane**. (see Figure 29, below).

Figure 29 - Personal Folders

19. To view the contents of the .pst folders, click the **Folder List** shortcut in the **Navigation Pane**.

20. To **Move** messages, select messages.

21. **Drag and Drop** to new folder.
Accessing Junk Email Options

The Junk E-mail Options work in conjunction with other filtering features to prevent delivery of unwanted mail messages. It uses updated spam lists to evaluate if a message should be treated as junk mail based on the following:

- **By default**, the filter is set to Low to catch the most obvious junk e-mail. Any message that is caught is moved to the Junk E-mail folder.
- Filtering is based on the content of the message in general and uses analysis of the structure of the message to determine the probability that it is junk e-mail.
- Uses the Safe Senders List so mail from known senders is not treated as junk e-mail.
- Users in the Contacts Folders are automatically trusted by default; messages from people in your Contacts folder will not be considered as junk e-mail.
- Addresses in the Blocked Senders List blocks specific e-mail addresses or domain names.
- Messages from within your organization are not treated as junk e-mail regardless of the content of the message.

To access additional Junk E-mail Options:

1. From the Tools menu, select Options.
2. Select the Preference tab.
3. Select the Junk Email… button (see Figure 30, below).
4. The Junk E-mail Options window displays.
5. Select the additional options for junk e-mail protection.
6. Click OK.

Figure 30 – Junk E-mail Options
Archiving Mail

To periodically archive your mail requires a .pst folder in a known location. Archiving can be done one of two ways:

- **Manually** moving mail messages from your mailbox to a .PST folder using the drag and drop method.
- **AutoArchive** items on a scheduled basis.
  - a. On the **Navigation Pane**, click **Folder List**
  - b. **Right-click** the folder you want to AutoArchive, click **Properties** (see Figure 31, below).

![Figure 31 – AutoArchive Properties](image-url)
c. In the **ZOther Properties** window, click the **AutoArchive** tab (see Figure 32, below).

d. Select either **Archive items in this folder using the default settings** or **Archive this folder using these settings**.

e. Select the necessary information to complete the archive.

f. Click **OK**.

Figure 32 – AutoArchive Properties
OUTLOOK 2007 CALENDAR FOLDER

Outlook 2007 Calendar Window

The Outlook 2007 Calendar Folder provides easy viewing of appointments, meetings and shared calendars. In addition, it provides easy access links to the Date Navigator, the Share My Calendars link, the Open a Shared Calendar link and to the Day, Week, Month viewing selections (see Figure 1, below).

Figure 1 Outlook 2007 Calendar Window
Choosing a Calendar View

There are three different ways to view the calendar, making it easy to find and view your availability, appointments and meetings. The options are:

- **Day** - Shows the events for one (1) particular day
- **Week** – To select work week or full week, click **Tools – Options – Calendar Options**
- **Month** – Shows the entire month

To return to the current day, click on **Today** (see Figure 2, below).

Figure 2 - Choosing a Calendar View

Viewing a Specific Date

1. To view a specific date, **Click** on the date in the **Date Navigator**, located at the upper right of the window (see Figure 3, below).
2. To move forward or back from the current month **Click** on the **Left** or **Right** arrow located on either side of **Date Navigator** month.

Figure 3 - Date Navigator
Sizing the Calendar

1. Point the mouse to the right or left border of the calendar.
2. **Click and hold** the mouse button, move the border as desired.

Creating New Appointments

1. **Click** the **New** icon on the toolbar.
2. The **Untitled - Appointment** display window appears (see Figure 4, below).

Figure 4 - Create New Appointment

3. Populate the **Subject Location**, **Start/End Time** fields.
4. Click the **Reminder** drop down arrow to select a reminder time.
5. In the **Text** box type any pertinent information for the appointment.
6. Click **Save & Close** to record the appointment on the calendar.

Creating a New Meeting Request

1. **Click** the **down arrow** on the **New** icon and select **Meeting Request** (see Figure 5, below).

Figure 5 - Create New Meeting Request
2. The **Untitled—Meeting** display window appears (see Figure 6, below).

Figure 6 - Untitled - Meeting Request Display Window

3. Click the **To**… button to display the **Select Attendees and Resources: Global Address List** window (see Figure 7).

Figure 7 – Global Address List (GAL)

4. Using the **GAL** (Global Address List), select the desired names.
5. Click **Required** or **Optional** to add people OR click **Resources** to add a room or equipment.
6. Click **OK**.
7. Populate the **Subject**, **Location**, and **Start and End Time**, **Reminder** and **Note** fields as desired.
8. To verify attendee availability, click on the **Scheduling Assistant** icon (see Figure 8, below).

Figure 8 - Scheduling Assistant Window

9. The **Scheduling Assistant** window displays, showing the availability of attendees based on the **Show As** option entered for each attendee.

10. Select a time when all invitees are available, or scroll the **Suggested Times** section to view attendee availability.

11. Click the **Appointment** icon to return to the **Meeting Request** display window.

12. Click the **Send** button.
Recurring Appointments/Meetings

1. Click on the **Recurrence** button on the **Options** group menu (see Figure 9, below).

![Figure 9 - Recurrence Button](image)

2. In the **Appointment Recurrence** window, under **Recurrence pattern**, select the appropriate pattern (see Figure 10, below).

![Figure 10 - Appointment Recurrence Window](image)

3. Under **Range of recurrence**, select the appropriate range.
4. Click **OK**.

Assigning Categories

1. Create a new appointment, from the **Appointment tab**, click the **Categorize** icon (see Figure 11, below).

![Figure 11 - Categorize icon](image)
2. From the **Categorize** drop down menu, **double-click** to assign one or more categories (see Figure 12, below).

Figure 12 – Categorize Menu

3. The item will reflect the number of categories selected (see Figure 13, below).

Figure 13 – Item with Two Categories Selected

4. To assign categories to existing items, **right click** the item, click **Categorize** and highlight the desired categories from the context menu (see Figure 14, below).

Figure 14 - Change Existing Appointment Category
**Renaming Predefined Categories**

1. In Calendar, select an item to activate the **Categorize** icon.
2. Click the **Categorize** icon.
3. Click **All Categories**…
4. In the **Color Categories** display window, select the **Category** to rename, click **Rename**.
5. **Type** the new name
6. Click **OK** (see Figure 15, below).

![Color Categories Window](image15.png)

**Adding a New Category:**

1. From the **Color Categories** display window, select the **Category** to rename, click **New**.
2. **Type** the **Name**: field type the name.
3. Select a **Color/Shortcut Key**.
4. Click **OK** (see Figure 16, below).

![Add New Category](image16.png)

**Deleting a Category**

1. From the **Color Categories** display window, select the **Category** to delete.
2. Click **Delete**.

**Note:** Deleting a category deletes it only from the Master Category List. Any existing items with an assigned category will maintain that category assignment.
## Outlook Calendar Symbols

In the Outlook calendar, symbols represent some of the features associated with meetings or appointments. The following table describes the symbols.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Recurring item" /></td>
<td>Recurring item</td>
<td>Represents an appointment or meeting that recurs on a specified schedule.</td>
</tr>
<tr>
<td><img src="image" alt="Exception to recurring item" /></td>
<td>Exception to recurring item</td>
<td>Represents an item, such as an appointment or meeting, that recurs on a specified schedule; however, this one instance is different — or an exception — from the usual pattern of the recurrence.</td>
</tr>
<tr>
<td><img src="image" alt="Data conflict" /></td>
<td>Data conflict</td>
<td>A conflict exists between the data on your local computer and the Microsoft Exchange Server. To resolve the conflict, open the item and follow the instructions shown on your screen.</td>
</tr>
<tr>
<td><img src="image" alt="Start time of an appointment or meeting" /></td>
<td>Start time of an appointment or meeting</td>
<td>Most commonly seen with multi-day items in the Week or Month views where a specific start and end time have been set. The time shown in the symbol matches the start time of the item.</td>
</tr>
<tr>
<td><img src="image" alt="End time of an appointment or meeting" /></td>
<td>End time of an appointment or meeting</td>
<td>Most commonly seen with multi-day items in the Week or Month views where a specific start and end time have been set. The time shown in the symbol matches the end time of the item.</td>
</tr>
<tr>
<td><img src="image" alt="Scheduled meeting" /></td>
<td>Scheduled meeting</td>
<td>A meeting with one or more people is scheduled.</td>
</tr>
<tr>
<td><img src="image" alt="Private item" /></td>
<td>Private item</td>
<td>If you share your calendar information with other people using Microsoft Exchange or are publishing calendar items to a Web site, marking items private prevents details such as subjects, notes, or location from appearing.</td>
</tr>
<tr>
<td><img src="image" alt="Reminder" /></td>
<td>Reminder</td>
<td>A reminder is associated with Appointment or meeting to give advance notice of a pending event.</td>
</tr>
<tr>
<td><img src="image" alt="Meeting Workplace" /></td>
<td>Meeting Workplace</td>
<td>A workplace is associated with appointment or meeting</td>
</tr>
<tr>
<td><img src="image" alt="File Attachment" /></td>
<td>File Attachment</td>
<td>A file attachment is associated with this item</td>
</tr>
<tr>
<td><img src="image" alt="More Items" /></td>
<td>More Items</td>
<td>There are more items than can be shown in the current view.</td>
</tr>
</tbody>
</table>
Sharing a Calendar Folder

Outlook Exchange allows users to share their Calendar Folder with other Exchange users and provides several permission level options that can be assigned to individuals they have shared their calendars with.

Sharing your Primary calendar:

1. In the Navigation Pane, under Calendars, click Share My Calendar…. (see Figure 17, below).

Figure 17 - Share My Calendar Link

2. The Sharing Invitation: …Calendar – Share display window opens.
3. In the To…, select the name of the person you want to share your calendar with (see Figure 18, below).

Figure 18 - Share Calendar Email Window
4. Provide **Subject:** information.
5. Check **Allow recipient to view your Calendar.**
6. Add appropriate information in the message body.
7. Click **Send.**
8. Review the confirmation and click **OK.**

**NOTE:** If you want to request access to a calendar other than the default Calendar, you must send an e-mail message to **Request permission to view recipient’s Calendar.**

### Opening a Shared Calendar Folder

Up to 30 calendars can be viewed side-by-side in the **Calendar** viewing pane. Shared calendars must be **opened** before they can be viewed.

1. Click the **Calendar shortcut** from the **Navigation Pane.**
2. Click **Open a Shared Calendar.**
3. In the **Open a Shared** Calendar display window, click the **Name… button** to select the person’s name from the **GAL** address book or type the name as it is listed in the **GAL** (see Figure 19, below).

![Figure 19 - Open a Shared Calendar Window](image)

4. The shared calendar name will appear under in the **Navigation Pane**, under **People’s Calendar** (see Figure 20, below).

![Figure 20 - User's Calendar Display](image)
Viewing Shared Calendar Folders

Shared calendars are assigned Read Only permissions when initially shared and can be easily viewed.

1. In the Navigation Pane, check the box next to calendar you wish to view.
2. The Shared Calendar selected will display to the right of the calendar currently being viewed (see Figure 21 below).
3. In the Navigation Pane, check only the boxes of those calendars you wish to view. Deselect those you do not wish to view.

Figure 21 - Viewing a Shared Calendar

Modifying a Shared Calendar Folder Permissions - Owners

1. Right-click the Calendar Folder to access its permissions.
2. Click Properties (see Figure 22, below).

Figure 22 – Calendar Properties
3. In the Calendar Properties display window, click the Permissions tab (see Figure 23, below).

Figure 23 - Calendar Properties - Permissions

4. Select the Name of the individual whose permissions you want to modify.
5. Modify the Permissions section as desired. Refer to Outlook 2007 Folder Permission Levels, page 66, for permission level descriptions.
6. Click OK.
OUTLOOK 2007 CONTACTS FOLDER

The **Contacts Folder** is the address book containing information for people and businesses that are not CSUN Exchange users. The **Contacts Folder** provides for multiple email addresses, telephone numbers, addresses, etc (see Figure 1, below).

Figure 1 - Contacts Display Window
Creating a New Contact

1. From the **Contacts Folder**, click the **New** icon on the toolbar.
2. Enter the **Full Name**, **Internet**, **Phone**, and **Address** information in the respective fields (see Figure 2, below).

**Figure 2 - New Contact Window**

3. Enter additional information in the **Picture** box; the **Business Card** section, and a **Notes** section.
4. Click **Save and Close**.
5. From the **New** contact display window, under the **Contacts** tab, **Communicate** group, there are several communications icons available; **E-Mail**, **Meeting**, etc. (see Figure 3, below).

**Note:** While the **GAL** does not impact user quota, information added to the **Contacts Folder** does. It is recommended that only pertinent data be included.

**Figure 3 - New Contact Communicating Options**
Creating Secondary Contacts Folder

1. From the Navigation Pane, click on Contacts (see Figure 4, below).
2. Under My Contacts right click Contacts.
3. From the submenu click New Folder…

Figure 4 - Create Secondary Contacts Folder

4. The Create New Folder window displays (see Figure 5).

Figure 5 – Create Secondary Contacts Folder
5. Enter a name for the new contact folder in the Name: field.
6. In the Folder contains: field select Contact Items.
7. In the Select where to place the folder: choose where you would like the folder to appear.
8. Click OK.
9. Verify that the folder appears in the correct place (see Figure 6, below).

Figure 6 - New Secondary Contact Folder

Sharing the Contacts Folder

1. From the Navigation Pane, click the Contacts Folder.
2. Click the Share My Contacts folder (see Figure 7, below).

Figure 7 - Sharing Contacts Menu
3. In the To… field of the Sharing Invitation… display window, select the names (see Figure 8, below).

Figure 8 – Sharing Contact Folder Email

4. Type an appropriate message to the individual.
5. Click the Send button.
6. Click the Yes to the Share this “My Contacts” contacts folder with” (see Figure 9, below).

Figure 9 - New Contact Approval Message

7. Click OK to the Your “My Contacts” contacts folder has been shared (see Figure 10, below).

Figure 10 - New Contact Acknowledgement Request
Opening a Shared Contacts Folder

1. The user will receive an email notification that someone has shared their Contacts Folder with them. To view a shared folder (see Figure 13, below).

Figure 13 - Contacts – Sharing Invitation Email in User Inbox

2. Open the email invitation and click the Open this Contacts folder icon (see Figure 14, below).

Figure 14 – Open This Contacts Folder Option
3. The folder will appear in the **Contacts Folder - Navigation Pane** under the heading of **My Contacts** (see Figure 15, below).

**Figure 15 - Viewing Shared Contacts Folder**

---

**Removing a Shared Contacts Folder Permissions - Owners**

1. Click the **Contacts Folder**.
2. Right-click the folder you want to modify permissions and select **Change Sharing Permissions…** (see Figure 16, right).

**Figure 16 - Shared Contact – Change Sharing Permissions**
3. Under the **Permissions** tab, in the **Folder Properties** display window, select the name you want to remove sharing permissions from (see Figure 17, below).

**Figure 17 - Contacts Folder Properties**

4. Click **Remove**.
5. Click **OK**.

**Note:** You can *temporarily suspend* shared permissions, by change the individual permissions to **None**. This allows you to reinstate permissions easier and faster.
OUTLOOK 2007 TASKS FOLDER

A task is a personal or work-related item you want to track through completion.

- A task can occur once or repeatedly.
- A recurring task can repeat at regular intervals or repeat until the date you mark the task complete. For example, sending status reports on the last Friday of every month, or performing a manual archive on month after the last archive.

Creating a New Task

1. In the Task Folder, click the New icon on the toolbar to display the Untitled—Task display window (see Figure 1, below).

Figure 1 - New Task Window

2. Enter Subject, Start date:, Due date:, Status & Priority information related to the task.
3. In the body of the task, type appropriate task notes.
4. Click Save and Close button.
Assigning a Task Request

1. On the Toolbar, click the down arrow on the New icon, select Task Request.
2. The Untitled – Task display window appears (see Figure 2, below).

Figure 2 - New Task Window

3. In the To... box select a name from the GAL.
4. Populate the Subject field, Due Date & Start Date, set the Status & Priority using the drop down arrow.
5. In the body of the task, type instructions or information about the task.
6. To track the task, select or clear the Keep an updated copy of this task on my task list check box and the Send me a status report when this task is complete check box.
7. Click the Send button to assign your task.
8. The individual will receive task assignment e-mail. (See Figure 3 below).

Figure 3 - Assigned Task Email
Accepting or Declining a Task Request

1. Open the Task Request email
2. Click the Accept or Decline button.
3. The Accepting Task display window appears.
4. Click either Edit the response before sending (type your comment in the message, and then click Send), or Send the response now (see Figure 4, below).
5. Click OK.

Figure 4 - Accepting Task Window

Sharing a Task Folder

This feature requires a Microsoft Exchange Server e-mail account.

1. Click the Tasks button in the Navigation Pane.
2. Under My Tasks, right click on the Tasks.
3. From the drop down menu, click Share Tasks… (see Figure 5, below).

Figure 5 - Share Tasks Menu
4. The **Sharing invitation: Linda L Llanes – Tasks – Share** display window appears (see Figure 6, below).

![Share Task Email](image)

**Figure 6 - Share Task Email**

5. Enter the name in the **To**… field or click the **To**… field to display the **Select Names: Global Address List** display window.

6. Check the **Allow recipient to view your Tasks folder** box

7. Click **Send**.

8. Click **Yes** (see Figure 7, below).

![Verify Share Task Message](image)

**Figure 7 – Verify Share Task Message**

**Opening Shared Tasks Folder**

1. Click the **Tasks** button in the Navigation Pane.

2. Click **Open Shared Tasks**.

3. Click the **Name** button and select the person's name from the address book.

4. Click **OK**.

5. Click the appropriate **Task Folder** under the **Other Tasks**.
Modifying a Shared Task Folder Permissions

1. To set permissions for a shared Task Folder, under Tasks, right click on Tasks
2. Select Change Sharing Permissions… (see Figure 8, below).

Figure 8 - Task - Change Sharing Permissions

3. The Task Properties window appears (see Figure 9, below).

Figure 9 - Task Properties - Permissions
4. In the **Task Properties** display window, under the **Permissions** tab, in the **Name** section, select the name to change Sharing permissions (see Figure 10, below).

7. In the **Permission Level** field use the drop down arrow to select the appropriate permissions. Refer to **Outlook 2007 Folder Permission Levels**, page 66, for permission level descriptions.

8. Right click the **OK** button.

---

**Figure 10 - Task Properties – Permission Level**

![Task Properties - Permission Level](image)
OUTLOOK 2007 NOTES FOLDER

**Notes** are the electronic equivalent of the paper sticky notes. Use Notes to jot down questions, ideas, reminders, and anything you would write on note paper. You can leave Notes open on the screen while you work. This is especially convenient when you’re using Notes for storing bits of information you may need later, such as directions or text you want to reuse in other items or documents.

**Creating a Note**

1. Click **New** button.
2. Type the text of the note.
3. To close the note, click the X in the upper-left corner of the **Note** window, and then click **Close**.
4. Task appears on desktop (see Figure 1, below).

Figure 1 - Note on Desktop

Tip: You can leave the note open while you work. When you change the note, the changes are saved automatically.

**Changing a Note’s Category**

1. Select and **right-click** the Note to change the category.
2. Click **Categorize**.
3. Select and **click** the new category from the drop down list.
4. The note will display the **Category** change (see Figure 2, below).

Figure 2 – Change Category
Sharing the Notes Folder

1. Under My Notes, right click Notes.
2. Select Share Notes… (see Figure 3, below).

Figure 3 - Sharing Notes Menu

3. In the Sharing invitation: YOUR NAME – Notes – Share display window, click the To... field
4. The Select Names: Global Address List display window appears (see Figure 4, below).

Figure 4 - Sharing Note
5. Enter the name of the person you want to share your Notes with.
6. Select the Allow recipient to view your Notes Folder.
7. Click the Send button.
8. Click Yes to Share this Notes folder with Selected Name. 
   <selectedname@csun.edu>? (see Figure 5, below).

Figure 5 – Verify Share Notes Message

Opening Shared Notes Folder

1. Click Notes in the Navigation Pane.
2. Click Open Shared Notes… (see Figure 8, below).

Figure 8 – Open Shared Notes

3. Click the Name… button and select the name of the person who allowed you to see his/her notes (see Figure 9, below).
4. Click OK.

Figure 9 – Open Shared Notes Window
Modifying a Shared Notes Folder Permissions

1. To set permissions for a shared Notes Folder, under Notes right click on Notes Folder
2. Select Change Sharing Permissions... (see Figure 10, below).

Figure 10 - Notes - Change Sharing Permissions

3. The Notes Properties window appears (see Figure 11, below).
4. In the Notes Properties display window, under the Permissions tab, in the Name section, select the name to change Sharing permissions.
5. In the Permission Level field use the drop down arrow to select the appropriate permissions. Refer to the Outlook 2007 Folder Permission Levels, page 66, for permission level descriptions.
6. Click the OK button.

Figure 11 - Notes Properties – Permission Level
OFFICE OUTLOOK WEB ACCESS (OWA)

Office Outlook Web Access, OWA, is used to access your Outlook Exchange mailbox from any web-enabled computer using a web browser. Not all Outlook functionality is available using OWA, but the majority of basic functions are there. The recommended browser for accessing OWA is Internet Explorer. Using this browser ensures that you will have access to all of the features that OWA offers.

Internet Explorer Security

When using Internet Explorer as your browser you will need to add the CSUN website to the Trusted sites list in Internet Explorer and install an Active-X prompt as pop-ups are used by OWA.

1. In Internet Explorer, from the ‘Tools’ menu select Internet Option, and then select the ‘Security’ tab.
2. Click on Trusted Sites.
3. Click the Sites button.
4. The Internet Options display window opens (see Figure 1, below).

5. Enter the CSUN URL, https://www.csun.edu in the Add this website to the zone field.
6. Click the Add button.
7. Click Close.
Logging in to Outlook Web Access (OWA)

1. From your web browser, type the following URL, www.csun.edu/webmail.
2. The CSUN Webmail Direct page will appear (see Figure 2, below).
3. Outlook Exchange users click the here link.
4. The Office Outlook Web Access window appears.
5. Login using your CSUN User ID and Password.

Figure 2 – OWA Login Screen

6. Click the Log On button.
7. The Office Outlook Web Access window appears (see Figure 3, below).

Figure 3 – OWA Mail Window
Using the OWA Mail Folder

The OWA Mail window looks and functions similar to the Outlook 2007 client. Notice, that the shortcuts to Calendar and other tasks looks the same as Outlook client.

1. To create a new message, click **New** button in the OWA toolbar.
2. The **Untitled Message—Windows Internet Explorer** display window appears (see Figure 4, below).

Figure 4 - OWA Email Message Window

![Figure 4 - OWA Email Message Window](image)

3. Click the **To** button to get the **Address Book – Webpage Dialog** window; the **Global Address List** is the default address book (see Figure 5, below).

Figure 5 - OWA Address Book Window

![Figure 5 - OWA Address Book Window](image)
4. The Default Global Address List is selected.
5. Type the name in the Search field and click the Search icon.
6. Select the name and click the To:, Cc: or Bcc field to add the name.
7. Click OK.
8. The Untitled Message... window reappears with the names selected (see Figure 6, below).

Figure 6 - OWA Mail Attachment

9. Complete Subject line and text portion of the email.
10. To attach a file, click the Attach File icon (see Figure 6, above).
11. The Attach Files – Webpage Dialog display window appears (see Figure 7, below).
12. Click the Browse... button.

Figure 7 - OWA Attach Files and Choose File Window
13. The **Choose file** display window appears.
14. Select and **Click** the appropriate icon to populate the **Look in** field (see Figure 8, below).
15. Make the desired **File name:** and **Files of Type:** selection.
16. Click **Open** button.

Figure 8 - Choose File Attachment Window

![Choose file window](image)

17. The **Choose File** window updates to show available folders, select the desired folder, and **click** the **Open** button (see Figure 9, below).

Figure 9 - Choose File Available Folders

![Choose file available folders](image)
18. The updated **Choose file** display window appears, showing the data files available (see Figure 10, below).

Figure 10 Choose File Window - Selected File

19. Make the desired selection to populate the **File name** and **Files of type:** fields.

20. Click **Open**.

21. The **Attach Files – Webpage Dialog** display window reappears showing the correct path of the file selected in the **Browse** field (see Figure 11, below).

22. Click the **Attach** button.

Figure 11 - Attachment Path
23. The file name will appear in the **Untitled Message** display window in the **Attach…** field (see Figure 12).
24. Complete the mail message.
25. Click the **Send** button.

Figure 12 - OWA Message with Attachment
Using OWA Calendar Folder

The OWA Calendar Folder has many of the same options as the Outlook 2007 client calendar. You can view and create appointments and meetings as well as utilize the scheduling assistant options, the same way when using the client.

1. Click the Calendar link to display the OWA calendar window (see Figure 13, below).

Figure 13 - OWA Calendar Window

2. The calendar toolbar provides the same options available on the client (see Figure 14, below).

Figure 14 - OWA Calendar Toolbar

- Check Messages
- Delete
- Calendar View
- Current Day
- Reading Pane
- New Appointments/Meetings
Using OWA Contacts Folder

The OWA Contacts toolbar (see Figure 15, below) allows you to access your Contacts list to view, add and modify contacts. If you are saving your contacts in a Personal Address Book and not in Contacts, you will not be able to view them using OWA. These are saved to your C: drive of your computer and not the server.

- To print contact information the contact must be opened.
- To open a contact, double-click on the contact name.

Figure 15 - OWA Contacts Toolbar

Using OWA Tasks Folder

The OWA Tasks Folder provides access to your Outlook Tasks folder. In the OWA version of the Tasks Folder you can only assign a task to yourself and view any other tasks already created. (see Figure 16, below).

Figure 16 - OWA Task Toolbar
# OUTLOOK 2007 FOLDER PERMISSION LEVELS

<table>
<thead>
<tr>
<th>Permission Level / Role</th>
<th>Permissions Granted by Owner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner **</td>
<td>Create, read, modify, and delete items (An item is the basic element that holds information in Outlook [similar to a file in other programs]. Items include messages, appointments, contacts, tasks, journal entries, notes, etc.) and files/subfolders. An owner can give/modify the permission levels for a folder.</td>
</tr>
<tr>
<td>Publishing Editor**</td>
<td>Create, read, modify, and delete all items, files, and subfolders</td>
</tr>
<tr>
<td>Editor</td>
<td>Create, read, modify, and delete all items and files.</td>
</tr>
<tr>
<td>Publishing Author</td>
<td>Create and read items and files, create subfolders, and modify and delete items and files they create.</td>
</tr>
<tr>
<td>Author</td>
<td>Create and read items and files, and modify and delete items and files they create.</td>
</tr>
<tr>
<td>Contributor **</td>
<td>Create items and files only. The contents of the folder do not appear.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Read items and files only.</td>
</tr>
<tr>
<td>Custom**</td>
<td>Perform activities defined by the folder owner.</td>
</tr>
<tr>
<td>None</td>
<td>No permissions to access Outlook items.</td>
</tr>
</tbody>
</table>

**Does not apply to delegates

**Note:** With Author or Editor permissions, a delegate has send-on-behalf-of permission. Sent messages contain both the manager's and delegate's names. Message recipients see the manager's name in the **Sent On Behalf Of** box and the delegate's name in the **From** box.